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Food Defense Plan Builder v2.0 Legal Disclaimer  
 

The Food Defense Plan Builder (FDPB) version 2.0 is a user-friendly tool designed to help owners and 
operators of a food facility in the development of a food defense plan that is specific to their facility and may 
assist them with meeting the requirements of the Mitigation Strategies to Prevent Food Against Intentional 
Adulteration regulation (21 CFR Part 121).  A food defense plan is a set of written documents that is based 
upon food defense principles and incorporates a vulnerability assessment, includes mitigation strategies, 
and delineates food defense monitoring, corrective action, and verification procedures to be followed.  A 
written food defense plan is essential for you to significantly minimize or prevent significant vulnerabilities 
related to intentional adulteration of food.   

Although the content of the Food Defense Plan Builder v. 2.0 is consistent with the Food and Drug 
Administration’s (FDA) existing regulations and guidance, use of the Food Defense Plan Builder v 2.0 does 
not constitute FDA approval of a food defense plan or guarantee compliance with FDA’s requirements.   

The Food Defense Plan Builder v. 2.0 is a desktop tool that resides only on the user’s computer.  FDA does 
not track or monitor its use and does not have access to any content or documents saved using this tool.  
FDA has taken all reasonable precautions in creating the Food Defense Plan Builder v. 2.0 and the 
documentation accompanying it.  However, FDA is not responsible for errors, omissions or deficiencies 
regarding the tool and the accompanying documentation.  The Food Defense Plan Builder and the 
accompanying documentation are available for download “as is” and without warranties of any kind, either 
expressed or implied, including, but not limited to, warranties of performance, merchantability, and fitness 
for a particular purpose.  FDA is not making a commitment in any way to regularly update the tool and the 
accompanying documentation.   

Responsibility for the interpretation and use of the Food Defense Plan Builder v. 2.0 and of the 
accompanying documentation lies solely with the user.   

Third parties’ use of or acknowledgment of the tool and its accompanying documentation does not in any 
way represent that FDA endorses such third parties or expresses any opinion with respect to their 
statements. 
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Introduction 
 

The U.S. Food and Drug Administration’s (FDA) Food Defense Plan Builder (FDPB) is a user-friendly, stand-
alone desktop application designed to assist owners/operators of a food facility develop a personalized food 
defense plan.  A food defense plan (FDP) is a set of written documents that is based upon food defense 
principles and incorporates a vulnerability assessment, includes mitigation strategies, and delineates food 
defense monitoring, corrective action, and verification procedures to be followed. 

This user guide is NOT intended to provide guidance or training on FDA’s regulatory requirements.  Refer to 
the final rule entitled “Mitigation Strategies to Protect Food Against Intentional Adulteration” and FDA’s 
guidance document entitled: “Mitigation Strategies to Protect Food Against Intentional Adulteration: 
Guidance for Industry” for detailed guidance and discussion on the IA rule requirements.  You can find both 
of these documents on https://www.fda.gov/food/food-defense. 

The FDPB guides users through a series of sections that, when completed, make up the content for a FDP for 
the facility.  The FDPB is a desktop application that resides only on the user’s computer.  FDA does not track 
or monitor use of the FDPB, and FDA does not have access to any content or documents developed using 
this tool.  The user’s FDP can be stored on their local hard drive or other location as selected by the user.  
Food defense plans may include sensitive information and it is the user’s responsibility to ensure files are 
saved and stored in a secure location.    

Objective 
This user guide provides instructions on how to use the FDPB to do the following: 

• Install the Food Defense Plan Builder   
• Open the Food Defense Plan Builder  
• Create and Edit Facility Information 
• Create and Edit Product/Process Descriptions 
• Create and Edit Vulnerability Assessments 
• Create and Edit Mitigation Strategies 
• Create and Edit Monitoring Procedures 
• Create and Edit Corrective Actions Procedures 
• Create and Edit Verification Procedures 
• Add Supporting Documents 
• View and Customize the Food Defense Plan Report 
• Sign the Food Defense Plan 

Refer to the final rule entitled “Mitigation Strategies to Protect Food Against Intentional Adulteration” and 
FDA’s guidance document entitled: “Mitigation Strategies to Protect Food Against Intentional Adulteration: 
Guidance for Industry” for detailed guidance and discussion on the IA rule requirements.    

https://www.fda.gov/food/food-defense
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General  
System Requirements 
For the Food Defense Plan Builder to operate correctly, your computer configuration must meet the 
minimum requirements outlined in the table below. Note that the FDPB does not work on the MAC 
operating system.  

Components Minimum Recommended 
Computer 2.80 GHz 3.0 GHz 
RAM 1 GB 2 GB 
Hard Disk Space 100 MB 125 MB 
Operating System Windows 7 

 
Windows 7, Windows 8.1, and 
Windows 10 

.NET 4.5 4.5 Full 
Graphics Card SXGA+ SXGA+ 

 
Other than the computer’s Windows operating system, no additional software is needed to install or 
operate the Food Defense Plan Builder.  However, if you would like to use the import function as outlined in 
the Importing Process Steps (in the Vulnerability Assessment chapter), you will need a software program 
(such as Microsoft Excel) that will open, edit, and save .xls files. 

Downloading the FDPB 
Download the FDPB from FDA’s website at https://www.fda.gov/food/food-defense.  The FDPB will 
download as a .zip file.  Once downloaded, save it to your computer.  

Uninstalling the FDPB 
If you have a previous version of FDPB installed on your computer, follow these steps to uninstall 
the previous version completely from your computer:  

1. Click the Start button, type “Programs and Features” in the search box, and then select 
Programs and Features. 

2. Select "Food Defense Plan Builder" and click “Uninstall/Change.”  This will uninstall the 
FDPB from your computer.  

https://www.fda.gov/food/food-defense
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Installing the FDPB  
After you have downloaded the FDPB .zip file from the FDA website and saved it on your compute, you will 
need to unzip the file.   The FDPB installation file is an .exe file.  

Unzip 
Using Windows File Explorer, locate the “PlanBuilderInstall.zip” file, right-click on it and select 
“Extract All...”  You will need select the file location where you want the .exe file to unzip to.   
 

 
Figure 1-1: Extract Downloaded File 

Install 
Using Windows File Explorer, go to the folder where you unzipped the file to and locate and open 
the “PlanBuilderInstall.exe” file.   
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Figure 1-2: Run Installation 

Double click on “PlanBuilderInstall.exe” to start the installation wizard.  You must agree that you 
have read the Legal Disclaimer in order to continue with the install.  Once the installation is 
complete, the FDPB will open automatically.  

 
Figure 1-3: Food Defense Plan Builder 

 

Opening a Saved Food Defense Plan from version 1.0 Using FDPB version 2.0  
If you have a saved .fdp file that was created using FDPB version 1.0 (v 1.0), you will be able to open that file 
and convert it to a version 2.0 (v 2.0) file.  Note that the conversion to v 2.0 is permanent.  Once the file is 
converted, you will not be able to reopen the file in v 1.0.   You will see a warning message when you have 
opened a v 1.0 file in v 2.0.    
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Figure 1-4: Conversion Warning 

 

After converting your file to v 2.0, the content from the Broad Mitigation Strategies, Emergency Contacts, 
Action Plan, and Supporting Documents sections of v 1.0 will automatically be converted into PDF format 
and saved as a document in the Supporting Document section of v 2.0.  Although the Vulnerability 
Assessment information from v 1.0 will copy over into v 2.0, note that in v 2.0, there are three elements that 
can be scored as compared to the two elements in v 1.0.   The two scores from v 1.0 will automatically carry 
over into v 2.0, but there will be a third element (Element 1: Potential Public Health Impact) that will be left 
blank.  

Opening FDPB version 2.0  
 
When you open the FDPB, you will see a Quick Start dialog box that gives you the option to create a new 
food defense plan or to open an existing saved food defense plan.  You can click on the Do Not Show Again 
checkbox to avoid seeing this dialog box every time you open the FDPB.  You can also prevent the Quick 
Start dialog box from opening in the future by going to the Tools Menu and unchecking Show Quick Start 
Dialog.  
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Figure 1-5: Quick Start Dialog 

 

Main Menu 
The Main Menu options (File, Edit, View, Tools, and Help) are similar to those found in other Microsoft 
Windows applications with which you may be familiar. 

 
Figure 1-6: Main Menu 

File Menu 
The File menu has options such as New, Open, Close, Save, Save As, and Print. 

• New - Creates a new food defense plan  
• Open - Opens an existing food defense plan  
• Close - Closes the current food defense plan (user is prompted to save the file before closing) but 

keeps the FDPB open 
• Save - Saves updates to the food defense plan.  Note that the FDPB automatically saves your food 

defense plans every 5 minutes.   
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• Save As – Saves the food defense plan under a new file name  
• Print – Opens up the a Custom Food Defense Plan dialog box where you can select the 

Product/Process Name and the Sections to include in a printed plan.   You can also go to the same 
Custom Food Defense Plan dialog box by clicking on the Food Defense Plan Section 

• Recent Files — Displays all recently opened files in FDPB 
• Exit – Closes and exits the FDPB.  

Edit Menu 
The Edit Menu provides options to Undo, Redo, Cut, Copy, Paste, and Select All. 

 
Figure 1-7: Edit Menu 

View Menu 
The View Menu displays a list of all of the sections in FDPB. Selection of one of the items from the list takes 
you directly to the selected section in the FDPB.  

Th
Tools Menu 

e Tools menu at the top of the FDPB includes five options that you can turn on or off.   

 
Figure 1-8: Tools Menu 

Show Quick Start Dialog  
By default, this option is checked, which means that a quick start dialog box opens automatically each time 
you open the FDPB.  The quick start dialog box this allows you to either create a new or open an existing 
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food defense plan.  Unchecking this option will prevent the Quick Start Dialog box that normally appears 
when users start the FDPB from appearing. 

 
Show VA Details  
In the Vulnerability Assessment section you have the option to show or hide the bottom detailed 
information pane.  The default setting for when you open the FDPB for the first time is that the VA details 
are shown (checked).  To hide the VA details, uncheck “Show VA Details.”  Note that if you hide or uncheck 
this option, that will be set as the new default whenever you reopen FDPB.   

 
Allow Internet Access  
In the Mitigation Strategies section, you will need internet access if you want to access FDA’s online Food 
Defense Mitigation Strategies Database.  By default this will be unchecked.   To allow internet access, check 
Allow Internet Access.  Note that if you uncheck this option, then the functionality will be turned off when 
you open the FDPB in the future.  
   

Print Report Header  
You can include a report header to the top of your printed food defense plan.  Click on Print Report Header 
to open up a separate dialog box where you have the option to type in text for the header and select 
whether you want the header to be printed on just the cover sheet or on all pages of the food defense plan.  
The pre-filled text is “For Internal Use Only” and by default both Print on Report Header on Coversheet and 
Print on Report Header on all pages is checked. Note that if you uncheck this option, then the functionality 
will be turned off when you open the FDPB in the future.  You can turn it back on by checking Print Report 
Header again.    

Spell Check  
By default, this option is checked when you initially open FDPB.  A check here means that the Spell Check 
functionality is turned on.  Unchecking this option will turn off the Spell Check functionality.  Note that if you 
uncheck this option, then Spell Check functionality will be turned off when you open the FDPB in the future.  
See Spell Check.  

Help Menu 
The Help Menu includes the User Guide, FDPB Legal Disclaimer, and About the FDPB.  You can see the 
version number of the FDPB in the About the FDPB.   
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Saving a Food Defense Plan  
 
To save a food defense plan, you can either click on the save  button or go to File Menu and select “save” 
or “save as.”  Food defense plans created in FDPB are saved as .fdp files.  Select the folder where you want 
the .fdp to be saved and enter a name for the .fdp file.  Note that the folder and location where you save the 
.fdp is also where Supporting Documents will be saved.  While you can create more than one food defense 
plan file as needed, each separate plan will need to be saved as a separate .fdp file. 

If you create a new FDP and have not saved it within 5 minutes, the FDPB will remind you to save your FDP. 
Once saved, the FDPB will also automatically save your FDP every 5 minutes.   

 
Figure 1-9: Save Reminder 

 

Spell Check  
FDPB v2.0 includes a Spell Check feature.  By default, spell check is turned on when you initially install and 
open the FDPB.  You can turn spell check off by going to the Tools Menu and unchecking Spell Check.  When 
spell check is turned on, any words that is misspelled or unrecognized by the spell checker will have a red 
squiggly underline under it.  Right click on the word that is underlined in red to see suggested spelling, or to 
add the word to the spell checker Dictionary, or to ignore the misspelling or unrecognized word. 

 
Figure 1-10: Spell Check 
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Facility Information 
Introduction 
The Facility Information section allows you to enter information about the facility and the parent company.   

 
Figure 2-1: Facility Information 

The fields of the Facility Information Section are: 

• Facility Name – Name or identifier of the facility. If a company has multiple facilities, you 
can specify the facility name or identifier in this field.   

• Parent Company Name – Name of the parent company of the facility.   
• Facility Address – Street address where the facility is physically located.  
• Facility City – City where the facility is physically located. 
• Facility State – State where the facility is physically located.  
• Country – Country where the facility is physically located. 
• Postal Code – Zip code where the facility is physically located. 
• Phone Numbers – Phone numbers for the facility.  Phone number descriptions are editable. 
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• Website – The company’s website.  
• Facility Identifier Numbers- Identifier numbers that are associated with the facility that you 

would like to be included in the FDP.  The FDA registration number and DUNS# appear as a 
default.  The FDA registration number is the unique number assigned to the facility when it 
was registered with the FDA.  For more information on FDA requirements for Registration of 
Facilities visit:  https://www.fda.gov/food/guidance-regulation-food-and-dietary-
supplements/registration-food-facilities.  You can delete the two default identifiers and/or 
add other identifier numbers, which may include those from USDA, State, or company-
specific numbers.  See Adding Facility Identifier Numbers and Deleting Facility Identifier 
Numbers.  

• Facility Description – General description of the facility, including any physical attributes.   
• Employee Description – Information about the employees at the facility, including vocation 

types, number of employees, etc. 
• Other Description – Information about the employees at the facility, including vocation 

types, number of employees, etc. 

Adding Facility Identifier Numbers 
To add a new facility identifier to the Facility Identifier Numbers list, click on the   icon to insert a new 
row in the table.  Click on the new row to enter the Description and Number of the Facility Identifier 
Number.   

 
Figure 2-2: Add Facility Identifier Number 

Deleting Facility Identifier Numbers 
To delete an existing Facility Identifier Number, click on the row of the identifier to be deleted, and then 

click the  icon at the top of the form.  This will permanently remove that identifier from the list.  Figure 2-
3 illustrates the highlighted row, marked for deletion, on the Facility Identifier Numbers list. 

https://www.fda.gov/food/guidance-regulation-food-and-dietary-supplements/registration-food-facilities
https://www.fda.gov/food/guidance-regulation-food-and-dietary-supplements/registration-food-facilities
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Figure 2-3: Delete Facility Identifier Number from List 

Food Defense Team  
The Food Defense Team area of the Facility Information section allows you to record in the FDP the 
individual(s) who were involved in the development of this FDP and designate those who have a 
responsibility to maintain and/or implement the plan.  In addition, you can upload education, training, 
and/or experience documentation for individuals on the team.  

Adding Food Defense Team Members 
To add an individual to the Food Defense Team list, click on the   icon to insert a new row in the table.  
Click into the new row within the Name column and add the name of the individual.    

 
Figure 2-4: Add Individual to Food Defense Team 
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T
Deleting Food Defense Team Members 

he process of deleting an existing member from the Food Defense Team is similar to adding a new 

member.  To delete, click on the row of the individual to be deleted, and then click the  icon.  This will 
permanently remove that name and title from the list.  Figure 2-5 illustrates the highlighted row, marked for 
deletion, on the Food Defense Team member list. 

 
Figure 2-5: Remove Food Defense Member from List 

Food Defense Team Details 
You can click on the “Edit” button in any row to open up the Food Defense Team details dialog box where 
you can select or type in the team member’s responsibility enter their email address and phone number.   

 
Figure 2-6: Edit Food Defense Member’s Responsibility 

Check the appropriate responsibility for the chosen Food Defense Team member.   Use the Other checkbox 
to enter a custom responsibility.  You can also add a phone number and email address for the team member 
in the details dialog box.  
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Figure 2-7: Select Food Defense Member’s Responsibility 

Adding Education, Training, and/or Experience Documentation  
To add education, training, or experience documentation for a food defense team member, click on Edit for 
the individual to open up the Food Defense Team Details dialog box and click on the   icon next to 
Education, Training, and/or Experience Documentation.  An Add Document dialog box will appear where 
you can enter a description of the documentation.  Click on Select File to select the file you would like to 
upload and click on OK to complete the upload.  Enter a description of the document.  By default, the 
document that you upload will be saved into a subfolder called “Documents” in the same folder as your 
saved food defense plan (.fdp) file.   Use the Subfolder field to create or save the document into a new or 
existing subfolder.   Only the file name and description of the documents are printed in the Food Defense 
Plan.   
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Figure 2-8: Add Document  

To delete a document, click on the row of the document to be deleted, and then click the  icon.   

 
Figure 2-9: Delete Document  
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Product/Process Description 
Introduction 
The Product/Process Description section of the FDPB allows you to input the products and/or processes that 
are covered in this food defense plan.  If you are grouping similar food products or processes, you can use 
the Product/Process Description section to specify which food products or processes the groupings apply to.  

 
Figure 3-1: Product/Process Description 
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Adding a Product/Process 
Click on the   icon to add a new product/process to the list.  When you click on the  icon, the 
Product/Process Description dialog box is displayed.   Enter the name of the product/process, description, 
ingredients, intended use, intended consumers, and storage and distribution.  To enter more than one 
product/process, click the Save and Add New button.  This will save the existing product/process and keep 
the dialog box active so more products/processes can be entered.   

 
Figure 3-2: Add Product Form 

Deleting a Product/Process 
To delete a product/process, click on the  icon.  When you delete a product/process, all data associated 
with that product/process will be deleted, including vulnerability assessment, mitigations strategies, 
corrective action procedures, monitoring procedures, and verification procedures.  The FDPB will display a 
warning message as shown in Figure 3-3. 

 
Figure 3-3: Delete Product/Process Warning 
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Vulnerability Assessment 
Introduction 
The Vulnerability Assessment section allows you to conduct and document a vulnerability assessment for 
the products/processes at your facility.  You can enter the process steps for a product/process and 
determine which process steps are actionable process steps using either the Key Activity Types method, 3 
Elements, or a combination of the two (also known as the Hybrid Approach).  The steps that you identify as 
actionable process steps will automatically copy over to the Mitigation Strategies, Monitoring Procedures, 
Corrective Action Procedures, and Verification Procedures Sections.   

 
Figure 4-1: Vulnerability Assessment 

The top of the Vulnerability Assessment (VA) section shows a summary of the process steps for the 
Products/Processes selected.  You can view All Product/Processes or click on the dropdown menu to select 
one Product/Process.  
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Figure 4-2: Filter Vulnerability Assessments by Product/Process Name 

 

At the bottom of the VA section is the details pane, which shows the VA details for the process step 
selected.  There is an option to either view or hide the VA details pane for a selected process step.  By 
default, the VA details pane is shown.   

 
Figure 4-3: Vulnerability Assessment Details 
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To turn this option off and hide the VA details pane, go to the Tools Menu and unselect Show VA Details. 
See Show VA Details.  

 
Figure 4-4: Vulnerability Assessment Details Hidden 

 

Adding a Process Step  
To add a new Process Step, click the  icon.  A new Vulnerability Assessment (VA) dialog box will open.  

 
Figure 4-5: Vulnerability Assessment Dialog Box 
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Select an existing Product/Process Name from the dropdown and enter a Process Step name and Process 
Description.   Choose the VA method you would like to use to conduct the vulnerability assessment for this 
process step: Key Activity Type or 3 Elements.  Note that you can select a different method for each process 
step.  For example, process step 1 you can choose Key Activity Type method but for process step 2 you can 
choose 3 Elements. This is also how you would use the FDPB to conduct a VA using the Hybrid Approach (a 
combination of both the Key Activity Types and 3 Elements).    Note that the FDPB will save the data that you 
enter, even if you decide to change to the other VA method.  The method that is selected when you close 
out the VA dialog box will be the one that shows in the main VA screen and the Food Defense Plan.   

Reordering Process Steps 
To change the ordering/numbering of a process step, click to highlight the process step you would like to 
move and hold and drag it to the desired new location.  The process steps will be automatically renumbered.  

Sorting Process Steps  
You can sort the process steps by clicking on the column header that you want to sort by.   

Sort by Sum 
To sort the process steps by Sum, click on the Sum header and the process steps will sort by lowest sum to 
highest sum.  Click on the Sum header again and the process steps will sort by highest sum to lowest sum.   
Note that if you used the Key Activity Type method to assess a process step, there is no numeric sum.  
Instead, you will see a dash “-“ mark in the sum column for that process step.  If you used the 3 Elements 
method and scored any one of the three elements with a score of “1” then the Sum column will show “N/A,” 
which stands for not applicable.  If you used the 3 Elements method and did not score all three elements  
Process steps that were assessed using the 3 Elements VA method   

Sort by Actionable Process Step 
To sort by actionable process steps, click on the Actionable header twice to see the process steps that are 
identified as actionable process steps at the top.  

Importing Process Steps 
The FDPB allows you to import existing process steps and descriptions into the VA section.  It also allows you 
to important completed vulnerability assessments conducted outside of the FDPB.  To import either process 
steps or a completed vulnerability assessment, you will need to download the Microsoft Excel (.xls) template 

from the FDPB.  Click on the Download Excel Import Template  button.  You will be prompted to select a 
Directory folder where you want to save the template and a Filename for it.  In order to open the template, 
you must have either Microsoft Excel installed on your computer or another program that can open .xls files.  
The template includes four columns – Process Step #, Process Step Name, Process Step Description, and 
Actionable Process Step? (Y/N). Figure 4-6 shows a sample import template.  
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Figure 4-6: Template Sample 

Once you have populated the template and saved it, click on the Import Excel Template  button to 
import the data into the FDPB.  The Process Step Name must contain content for the FDPB to import the 
data in that row.  If a row does not have a Process step name, the data for the entire row will not be 
imported.   

 
Figure 4-7: Import Process Steps from Excel Worksheet 

Use the file selection dialog box to choose the saved Excel file to import. See Figure 4-8.  
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Figure 4-8: Select Excel Worksheet 

 

Select the Product/Process Name with which you want to associate the import steps.  Click OK to import. 

 
Figure 4-9: Process Steps Loaded from File  

 

Then you should see the process steps imported into the FDPB. See Figure 4-10. 
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Figure 4-10: Imported Process Steps 

Copy Process Steps 
The FDPB allows you to copy process steps from a Process/Product.  To copy some or all of the process steps 
from one Process/Product to a new or existing product, click on the Copy Process Steps button as shown in 
Figure 4-11.      

 
Figure 4-11: Copy Process Steps Button 

When you click on the Copy Process Steps button, the Copy Process dialog box will open.  On the left side, 
select an existing Process/Product Name from the dropdown list where you want to copy a process step 
from and on the right side, select either another existing Process/Product Name or enter a new 
Process/Product Name that you want to copy a process step to.  
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Figure 4-12:  Copy Process Steps 

 When you copy a process step, all of the data associated with that process step will also copy over, 
including vulnerability assessment and all calculations (if applicable), mitigation strategies and explanations, 
monitoring procedures, corrective action procedures, and verification procedures.   

Assessing a Process Step using Key Activity Types  
When Key Activity Type (KAT) Method is selected, a short description for each Key Activity Type is shown in 
the right portion of the dialog box.  To see the full description of the KAT, click on the dropdown arrow  
next to the specific KAT.  Click on Key Activity Type drop down menu to see a list of options: Not Key Activity 
Type, Bulk Liquid Receiving and Loading, Liquid Storage and Handling, Secondary Ingredient Handling, and 
Mixing and Similar Activities. 

 
Figure 4-13: Vulnerability Assessment Dialog Box- Key Activity Types  
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If you select one of the four Key Activity Types, you will have the option to add sample content into the 
Explanation field.  Click on the Add Sample Content button to populate the Explanation field with the 
sample content.   

 
Figure 4-14: Vulnerability Assessment Dialog Box – 3 Elements 

Assessing a Process Step using 3 Elements Method 
When 3 Elements is selected, the VA dialog box changes to show a score and rationale fields for Elements 1, 
2, and 3, respectively.  For each Element, there is a dropdown menu that shows the scoring options.  When 
you click on one of the Elements, the table on the right side of the VA dialog box will change to that 
respective scoring table.  For example, when you click on the Element 2 Score dropdown menu or Element 2 
Rationale text box, the FDPB shows the scoring table for Element 2: Degree of Physical Access to the 
Product.    

Within the 3 Elements Method option, the FDPB has built in calculators for Element 1 and Element 3 to 
assist you with determining a score.   

Element 1 Calculator 

Click on the calculator  button next to the Element 1 dropdown menu to open the Element 1 Calculator.  
Choose either the Volume of Food at Risk or the Representative Contaminant Approach.   

If you choose Volume of Food at Risk, enter the Batch size and choose the appropriate unit of 
measurement; units are listed for both mass and volume.  Then enter the Amount of Product (Ingredient) in 
Final Serving.  Note that the calculator will automatically filter and only show the units of measurement that 
is the same type (either mass or volume) as what you selected in the Batch size.  Once you have entered 
both the Batch Size and the Amount of Product (Ingredient) in Final Serving, the Servings per Batch will 
automatically be calculated and the FDPB will show a Potential Public Health Impact score from the 
Element 1 scoring table based on the Servings per Batch calculated.  Click on Update Score to automatically 
have the Potential Public Health Impact Score applied.  

If you make changes to the Batch Size and/or Amount of Product (Ingredient) in Final Serving, click on the 
Update Score button to recalculate and the FDPB will update the Element 1 score accordingly.  You can also 
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clear the data in the Element 1 calculator by clicking on the Clear Data button.  Remember to click on 
Update Score if you want to apply the score from the Element 1 calculator. Figure 4-15 shows the Element 1 
Calculator.   

 
Figure 4-15: Element 1 Calculator 

If you choose Representative Contaminant Approach, enter the Batch size and choose the appropriate unit 
of measurement (units are in listed for both mass and volume).  Then enter the Amount of Product 
(Ingredient) in Final Serving.  Note that the calculator will automatically filter and only show the units of 
measurement that is the same type (either mass or volume) as what you selected in the Batch size.  Once 
you have entered both the Batch Size and the Amount of Product (Ingredient) in Final Serving, the Servings 
per Batch will automatically be calculated.  For the Representative Contaminant Approach, the FDPB does 
an additional calculation based on the 50% mortality rate set by U.S. Food and Drug Administration (FDA).   
The FDPB will show a Potential Public Health Impact score from the Element 1 scoring table based on the 
Servings per Batch, Mortality Rate, and Number of Deaths.   

You can recalculate the Servings per Batch by making changes to the Batch Size and/or Amount of Product 
(Ingredient) in Final Serving.  Click on the Update Score button to recalculate and the FDPB will update the 
Element 1 score accordingly.  You can also clear the data in the Element 1 calculator by clicking on the Clear 
Data button.  To close the Element 1 Calculator, click on Close.  Note that you can keep the Element 1 
Calculator open while you are working in the VA dialog box.  Once you close the VA dialog box, the 
calculator will also close.  

Element 3 Calculator 

Click on the calculator  button next to the Element 3 dropdown menu to open the Element 3 Calculator to 
calculate the Amount of Representative Contaminant Needed per Batch.  If you chose the Representative 
Contaminant Approach and input data in the Element 1 Calculator, the FDPB will automatically calculate the 
Amount of Representative Contaminant Needed per Batch based on the data that you entered in the 
Element 1 Calculator and FDA’s provided value for Representative Contaminant Dose Needed per Serving. 
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Unlike the Element 1 Calculator, the Element 3 Calculator does not automatically provide a score for 
Element 3. You will use Amount of Representative Contaminant Needed per Batch and the Element 3 
Scoring Table to help you in the analysis and determination of the score for Element 3.   

 

To close the Element 3 Calculator, click on Close.  Note that you can keep the Element 3 Calculator open 
while you are working in the VA dialog box.  Once you close the VA dialog box, the calculator will also close.  

 
Figure 4-16: Element 3 Calculator  

Editing a Process Step 
To edit an existing process step, select the process step in the VA summary table.  If you have the Show VA 
Details option turned on under Tools, you can either edit the process step in the details section below the 
VA summary table, or double click on the process step row.  Double-clicking on a process step row opens the 
VA dialog box for that step.   
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Figure 4-17: Edit Vulnerability Assessment Using Detail Panel  

If you have the Show VA Details option turned off under Tools, then your only option is to double click on 
the process step row to edit the VA information for that process step.  

Deleting a Process Step 
To remove a process step, click on the process step you wish to delete and then click on the  button.  A 
new dialog box will open to confirm the deletion of the process step. 

 
Figure 4-18: Delete Process Step 
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Mitigation Strategies 
Introduction 
The Mitigation Strategies section of the FDPB allows you to identify and document mitigation strategies for 
the actionable process steps that were identified in the Vulnerability Assessment section.  The process steps 
that were identified as actionable process steps in the Vulnerability Assessment section will automatically 
copy over to the Mitigation Strategies section.  The Mitigation Strategies section is divided into two main 
sections.  The top section contains all of the actionable process steps and the bottom section contains the 
mitigation strategies details for the selected actionable process step.    

The FDPB has the option to access and search for mitigation strategies on FDA’s online Food Defense 
Mitigation Strategies Database (FDMSD) and allows you to incorporate content directly from the FDMSD to 
your food defense plan.     

The top of the Mitigation Strategies section shows a summary of the actionable process steps for the 
Products/Processes selected.  You can view All Product/Processes or to view one Process/Product at a time, 
click on the dropdown menu to select the Product/Process. 
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Figure 5-1: Mitigation Strategy Section Layout 

Adding Mitigation Strategies 
There are two ways to add mitigation strategies.  One way is to type in a mitigation strategy and the other is 
to search for and input mitigation strategies from FDMSD.    

Manually Adding Mitigation Strategies  
To add a new mitigation strategy for an actionable process step, select the actionable process step in the top 

view pane and click on the  icon.  This will add a new row to the mitigation strategies details table.  
Double click on the new row and type in a Mitigation Strategy Description and Explanation.  You can also 
click on the Edit button to show the Mitigation Strategy form and enter the description and/or explanation 
in the form.  

 
Figure 5-2: Enter Mitigation Strategy Manually  
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Adding Mitigation Strategies from FDA’s Food Defense Mitigation Strategies Database 
The other way to enter mitigation strategies is via the FDMSD.  To search for mitigation strategies from 
FDMSD click on the Search button.  The Search button connects FDMSD and allows you to search for 
mitigation strategies to add to the selected actionable process step.  Internet connection is needed to access 
FDMSD.  The first time you click on the Search button, the FDPB will ask you to confirm that you would like 
to connect to the Internet. See Figure 5-3 below.  

 
Figure 5-3: Internet Connection to FDA Mitigation Database 

Click Yes to allow internet access.  You can check the Do Not Show Again box to avoid seeing the Internet 
Access confirmation dialog box in the future.  You can also turn this function on or off by going to the Tools 
Menu and checking or unchecking Allow Internet Access.    

Once you have granted internet access by checking yes, a Mitigation Database Search Results dialog box 
will display.  The FDPB connects with the FDMSD and imports the strategies directly from the database into 
your food defense plan.  Once successfully connected to the FDMSD, a new Mitigation Strategies Database 
Search Results dialog box will open.  You can use the Lookup Tool on the left side or the Search Engine Tool 
on the right to search the FDMSD.    

When using the Lookup Tool, select a Category and Step that best fits with the actionable process step 
selected and click on Search.  If you used the Key Activity Types method and aligned the process step with 
one of the four key activity types, then the FDPB will automatically show that key activity type in the 
Category field.  Click on Search to search the FDMSD.  The total number of results found is shown at the 
bottom of the dialog box - “Items Found.”  Select the process step that best fits your specific process step as 
shown in Figure 5-4 by clicking on Select.    
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 Figure 5-4: Mitigation Lookup Tool  

When using the Search Engine Tool, the name of the actionable process step will automatically show in the 
Search Term field.  Click on Search to search for process steps in FDMSD.  The total number of results found 
is shown at the bottom of the dialog box - “Items Found.”  Select the process step that best fits your specific 
process step as shown in Figure 5-5 by clicking on Select.    

 
Figure 5-5: Mitigation Results from Search 

When you click on Select, you will see a list of strategies that are associated with the selected process step.  
Figure 5-6 shows the list of strategies. 
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Figure 5-6: Mitigation Strategy Results from Search of the Process Step 

Select the strategy(ies) that you would like to add to your food defense plan by checking the box(es) next to 
the strategy and click on OK.  The selected strategy(ies) are displayed as a list as shown in Figure 5-7.  Each 
strategy will be placed in a separate row with a unique number in the details pane.  

 
Figure 5-7: Mitigation Strategies Added for a Process Step 
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Monitoring Procedures 
Introduction 
The Monitoring Procedures section of the FDPB allows you to identify and document monitoring 
procedures, the monitoring frequency, and the name(s) and stored location(s) of your monitoring records.  
The actionable process steps and mitigation strategies that were identified in the Vulnerability Assessment 
and Mitigation Strategies sections will automatically copy over to the Monitoring Procedures section.  The 
Monitoring Procedures section is divided into two main sections.  The top section contains a summary view 
of all of the actionable process steps, the associated mitigation strategies, and monitoring procedures.  The 
bottom section contains the monitoring procedures details for the selected mitigations strategy(ies).    

The top of the Monitoring Procedures section shows a summary of the actionable process steps and 
associated mitigation strategies for the Products/Processes selected.  You can view All Product/Processes or 
to view one Process/Product at a time, click on the dropdown menu to select the Product/Process. 

 
Figure 6-1: Filter Monitoring Procedures by Product 
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Documenting Monitoring Procedures 
To enter monitoring procedure(s) for a mitigation strategy, select the mitigation strategy in the top pane.  
Then in the bottom details pane, type in the corrective actions procedures into the two text fields- Identify 
and Correct the problem and Reduce the likelihood the program will recur (if applicable).  There is also a 
field where you can include the name(s) and stored location(s) of corrective action implementation records.  
To save and go to the next mitigations strategy, click Save and go to Next. To go back to the previous 
mitigation strategy, click Back. 

 
Figure 6-2: Monitoring Procedures  
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Corrective Action Procedures 
Introduction 
The Corrective Action Procedures section of the FDPB allows you to identify and document corrective action 
procedures and the name(s) and stored location(s) of your monitoring records.  The actionable process steps 
and mitigation strategies that were identified in the Vulnerability Assessment and Mitigation Strategies 
sections will automatically copy over to the Corrective Action Procedures section.  The Corrective Action 
section is divided into two main sections.  The top section contains a summary view of all of the actionable 
process steps, the associated mitigation strategies, and corrective action procedures.  The bottom section 
contains the corrective actions procedures details for the selected mitigations strategy.    

The top of the Corrective Actions Procedures section shows a summary of the actionable process steps and 
associated mitigation strategies for the Products/Processes selected. You can view All Product/Processes or 
to view one Process/Product at a time, click on the dropdown menu to select the Product/Process. 

 
Figure 7-1: Corrective Actions 
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Documenting Corrective Action Procedures  
To enter corrective action procedure(s) for a mitigation strategy, select the mitigation strategy in the top 
pane.  Then in the bottom details pane, type in the corrective actions procedures into the two text fields- 
Identify and Correct the problem and Reduce the likelihood the program will recur (if applicable).  There is 
also a field to include the name(s) and stored location(s) of corrective action implementation records.  To 
save and go to the next mitigations strategy, click Save and go to Next. To go back to the previous mitigation 
strategy, click Back.  



Page | 44  
 

 

 

Verification Procedures 
Introduction  
The Verification Procedures section of the FDPB allows you to identify and document verification procedures 
and list the name(s) and stored location(s) of your verification records.  The actionable process steps and 
mitigation strategies that were identified in the Vulnerability Assessment and Mitigation Strategies sections 
will automatically copy over to the Verification Procedures section.  The Verification section is divided into 
two main sections.  The top section contains a summary view of all of the actionable process steps, the 
associated mitigation strategies, and verification procedures.  The bottom section contains the verification 
procedures details for the selected mitigations strategy.    

The top of the Verification Procedures section shows a summary of the actionable process steps and 
associated mitigation strategies for the Products/Processes selected.  You can view All Product/Processes or 
to view one Process/Product at a time, click on the dropdown menu to select the Product/Process.  

 
Figure 8-1: Verification Procedures 
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Documenting Verification Procedures 
To enter verification procedure(s) for a mitigation strategy, select the mitigation strategy in the top pane.  
Then in the bottom details pane, type in the procedures and the records into the text fields.  To save and go 
to the next mitigations strategy, click Save and go to Next. To go back to the previous mitigation strategy, 
click Back. 
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Supporting Documents 
Introduction 
The Supporting Documents section allows you to add supporting documents to the food defense plan.  
Examples of supporting documents include flow diagrams, facility maps, recall plans, vulnerability 
assessments done outside of the FDPB, company-specific policies, etc.  The supporting documents may be in 
almost any format – Microsoft Visio, Excel, Word, Project, PDF, etc.  In addition, links or URLs may also be 
added and will appear on the list along with the other supporting documents.  Figure 9-1 shows an example 
of a document and a link/URL that have been added.   

 
Figure 9-1: Supporting Documents Section 
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Supporting documents are saved in the Documents subfolder within the same folder/directory as your saved 
food defense plan (.fdp) file.  Before adding documents, the food defense plan must be saved.  Saving the 
food defense plan creates a food defense plan file (.fdp), and also creates a folder structure that includes 
one main folder and two subfolders.  The main folder name is the name of your saved .fdp.  The subfolders 
under the main folder are Documents and SignedPlans (See Figure 9-2).  Supporting documents added to 
the plan are saved in the Documents subfolder.  

 
Figure 9-2: Folder Structure 

Adding A Supporting Document 
Click the add icon  to add a supporting document.  The Add Document dialog box will open (see Figure 9-
3).  The Add Document dialog box includes a text field for Description where you can enter a description of 
the file.  Then click on Select File to choose the file that you would like to add.  Use the Subfolder field to 
either create a new subfolder or save the added document in an existing subfolder.  New subfolders will be 
created under the Document subfolder.  Click on OK to add the document.  Note that only the filename and 
description are printed in the food defense plan.    

 
Figure 9-3: Add Supporting Documents 

Adding a Link or URL 
Click on the  icon to add a link/URL.  The Add URL dialog box will open (see Figure 9-4).   Enter a valid link/ 
URL. It must start with either http://,  https://, ftp://, or file:// .   Enter a description for the link/URL and 
click on OK to add the link/URL to your food defense plan.  
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Figure 9-4: Add URL 

After a document or link/URL is added, it will show in Supporting Documents table as shown in Figure 9-5.  
The text in the Description column can be edited directly in the table. 

 
Figure 9-5: Supporting Documents Table 

Copy Supporting Documents 
The FDPB includes a function to copy multiple documents from an existing folder on your computer into the 

Supporting Documents section.  Click on the copy icon  to add multiple supporting documents at a time.  
The Copy Documents dialog box will open.  On the left pane, chose the source directory/folder where you 

want to copy files from.  Click on the expand arrow  to see all of the files that are in that folder.  Then 
select the files that you want to copy into the food defense plan. Hold down the Shift key on your keyboard 

to select multiple file names.  Click on the right arrow button   to move the files over into the right 
pane.  The right pane contains the destination directory.  By default, the food defense plan’s Documents 
folder is selected as the destination.  Click on the OK button to complete the copying. 

 

 



Page | 49  
 

 
Figure 9-6: Copy Documents 

Another way to copy or delete supporting documents is using Windows File Explorer.  To copy supporting 
documents using File Explorer, open up two instances of Windows File Explorer.  In one instance of File 
Explorer (Source), find the files that you want to be copied into your food defense plan.  In the other 
instance, find the food defense plan folder and open up the Documents subfolder.  Copy the files and/or 
folders to the destination directory by either using the Copy and Paste functionality or drag and drop the 
files from the source folder into the Documents subfolder.    

Refresh the Supporting Documents section by clicking to any another section and then click back to the 
Supporting Documents to refresh the supporting documents list. 

 
Figure 9-7: Copy Documents Using File Explorer 
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Deleting Supporting Documents 
To delete a document or a link/URL, select the row of the document or link/URL and click on the delete 
button  to remove it.  The FDPB will display a warning message as shown in Figure 9-8.  You can also 
delete files from the Documents folder by using the Windows File Explorer. 

 
Figure 9-8: Delete Supporting Document 
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Food Defense Plan 
Introduction 
The content entered into the FPB is automatically compiled into a food defense plan report.  The Food 
Defense Plan section allows you to view, save, and print your food defense plan report.     

When you click on the Food Defense Plan section, the Custom Food Defense Plan dialog box will open.  
From there you can select the Product/Process Name and the Sections to include in your food defense plan 
report.      

Customizing a Food Defense Plan  
The Custom Food Defense dialog box allows you to choose the Product/Process Name and the Sections of 
the plan that you want to include in your food defense plan report.  The Custom Food Defense dialog box 
has three main sections: the toolbar, the section selector, and the report. 

 
Figure 10-1: Custom Food Defense Plan Layout 

Food Defense Plan Toolbar 
The items in the toolbar in Figure 10-1 are as follows, from left to right: 
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• Navigate History – not used. 
• Refresh - This reloads the food defense plan. 
• Navigation – The arrow icons allows you to proceed forward or backward through the pages of 

the food defense plan.  The arrow icons with a vertical line will place you on the first or last 
page, respectively. 

• Page Setup – Allows you to set the parameters, such as margins and page orientation to be used 
when the food defense plan is printed. 

• Page/Interactive Layout – By default, the food defense plan report is shown in print preview 
view and shows how the document will look, including what content is on each page, when it is 
printed.  You can switch the view of the food defense plan report from print preview view to an 
interactive layout view by clicking on this button.   

• Printer – Allows you to print the food defense plan report.  A Print dialog box will open. 
• Save/Export – Allows you to save or export the food defense plan report into Microsoft Excel, 

Microsoft Word, or PDF format.  Follow the prompts to save the food defense plan report.  
• Scaling – Use the dropdown options to increase or decrease the scale and size of the food 

defense plan report within the Custom Food Defense Plan dialog box. 
• Find – Type the text you wish to search for and then select Find.  Use the Next icon to find the 

next instance of the entered search text. 

Food Defense Plan Section Selector 
Use the Food Defense Plan Section Selector to choose which sections you would like to include in the food 
defense plan report.  By default, the FDPB generates a food defense plan coversheet as the first page of the 
report.  The FDPB also automatically includes content about the facility from the Facility Information section 
as the second page of the report.   

The Product/Process Name dropdown menu allows you select whether you want to include all of the 
Products/Processes in the food defense plan report or if you only want one specific Product/Process to be 
included in the report.   

Under the dropdown menu, you can check whether you want to select all of the sections the FDPB to be 
included in the food defense plan report or select only a subset of sections.   

Select All – By default the Select All checkbox is checked.  To unselect all, click on the checkbox to uncheck it 
or you can select the individual sections that you want to include in the report by clicking on the respective 
checkbox.  

Food Defense Team – The Food Defense Team information that you entered in the Facility Information 
section of the FDPB shown in a table form.  

Product/Process Descriptions – The information that you entered in the Product/Process Description 
section of the FDPB shown in a table form. 

Vulnerability Assessments – The information that you entered in the Vulnerability Assessment section of 
the FDPB shown in a table form.  If you chose to Select All of the Product/Process Names, then there will be 
a separate table for each Product/Process Name.  The tables are sorted by process step number with the 
lowest number listed first.  
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Mitigation Strategies – The information that you entered in the Mitigation Strategies section of the FDPB 
shown in a table form.  If you chose to Select All of the Product/Process Names, then there will be a 
separate table for each Product/Process Name. The tables are sorted by process step number with the 
lowest number listed first. 

Monitoring, Corrective Action, and Verification Procedures - These three sections are compiled into one 
single table within the food defense plan report.  The information that you entered in the Monitoring, 
Corrective Action, and Verification Procedures sections of the FDPB shown in a table form.  If you chose to 
Select All of the Product/Process Names, then there will be a separate table for each Product/Process Name. 
The tables are sorted by process step number with the lowest number listed first. 

Supporting Document List – The description(s) and file name(s) for the document(s) that you uploaded in 
the Supporting Documents section of the FDPB shown in a table form.  Note that the actual documents will 
not be printed with your food defense plan report, only the list.  You will have to open and print each 
supporting document separately.   

Education, Training and/or Experience Documentation List- The list of documentation that you uploaded in 
for the Food Defense Team under the Facility Information section shown in a table form.  Note that the 
actual documents will not be printed with your food defense plan report, only the list.  You will have to open 
and print each supporting document separately.   

Appendix – If you used the 3 elements method for any of the process steps in the Vulnerability Assessment 
section, the calculations from the Element 1 and Element 3 calculators will appear in the appendix.   

Report Header 
The food defense plan report will automatically have the Facility Name, Company Name, Signed Date, and 
Page number at the top of each page.  In addition to those default headers, you can include a custom report 
header to the coversheet of your printed food defense plan report or at the top of each page.  To set the 
report header, go to the Tools menu and select Print Report Header. (See Figure 10-2) Clicking on Print 
Report Header opens up a separate dialog box where you have the option to type in text for the header and 
select whether you want the header to be printed on just the cover sheet or on all pages of the food defense 
plan.  Figure 10-4 shows an example of a report header in a FDP report. 

The pre-filled text is “For Internal Use Only” and by default both Print on Report Header on Coversheet and 
Print on Report Header on all pages is checked. Note that if you uncheck this option, then the functionality 
will be turned off when you open the FDPB in the future.    
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Figure 10-2: Print Report Header Menu 

 

  
Figure 10-3: Report Header Dialog Box 

 

An example of a report header being included is shown in the report below. 

 
Figure 10-4: Report Header Example 
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Signature 
Introduction 
The Signature section allows you to sign your food defense plan (FDP).  It also allows you to keep a log and a 
copy of the signed versions of your FDP.  You can view the signed versions in view only mode, or you can 
export the signed food defense plan to create a new .fdp file.   

The export function allows you to copy content from the signed food defense plan into a new file that is 
editable and unsigned.  You may want to use this function if you are creating a new food defense plan but 
want to copy over the content from the signed plan.  

The Signature section is divided into three main areas: Electronic Signature, the Manual Signature, and 
Signed Documents. (See Figure 11-1).   

 
Figure 11-1: Signature 
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Electronic Signature 
To sign a FDP using an electronic signature, click the I Agree checkbox, enter comments, and type in the 
signatory’s name in the Electronic Signature field.  A Confirm Signature dialog box will show to confirm the 
electronic signature. (See Figure 11-2).   Use the comment box to enter any comments or notes about the 
version of FDP that is being signed.  This may be helpful if you made specific changes to the FDP and want to 
document those changes. Click on the Yes button to confirm and apply the electronic signature.  

 
Figure 11-2: Electronic Signature 

You can also sign the FDP by uploading an image of a signature.  Click on the folder button next to Signature 
Image.  A Load Signature Image dialog box will appear.  To prepare an image of a signature for loading, use 
Microsoft Paint or another program to crop the image of the signature to the size shown in the Load 
Signature Image dialog box (see Figure 11-3 below) and save the file.  Click on Select File to select the file to 
upload.  You will see a preview of the Signature Image in the Signature Image box. Click Ok to apply the 
Signature Image.  

 
Figure 11-3: Signature Image 
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Manual Signature 
To sign a FDP using the manual signature function, print the FDP and manually sign the document.  Then 

scan the signed copy of the FDP and save it in PDF format.  Click on the  folder icon and select the saved 
file.  Select a signed date and click on Upload to upload the PDF file. 

 
Figure 11-4: Manual Signature 

Signed Documents 
Signed documents are logged and kept in the Signed Documents list.  If a signed food defense plan was 
manually uploaded, a PDF icon is displayed in the first column of the list.  Click on the PDF icon to view the 
signed plan.  If a FDP is signed using the electronic signature option, you can view the plan by clicking on 
View.   

 
Figure 11-5: Signed Documents 

If you click on View, a new instance of the FDPB will open with a view only copy of your signed food defense 
plan.   Note that you can only edit the Facility Information and Supporting Documents sections when viewing 
a signed food defense plan.  The Export function allows you to export a copy of the signed food defense plan 
that can be edited; however, the exported plan will not have the signature applied.  When you click on 
Export, a Copy Food Defense Plan dialog box will open. You must save the exported FDP in the directory 
where you want the new FDP to be saved by selecting the directory and typing in a filename.  After you click 
OK, a new FDPB window will open with the exported plan.  You may now edit the new unsigned FDP.     
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